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Warning—Read This First! 

All personnel involved with the installation, operation or maintenance of the 
equipment described in this manual should read and understand the 
warnings and recommendations provided below. 

Static Sensitive Devices 

This equipment contains devices that are extremely sensitive to static 
electrical charges. Therefore extreme care should be taken when handling 
them as static electricity may be present on the body and clothing. Normal 
handling precautions involve the use of anti-static protection materials and 
grounding straps for personnel. 

Radiation 

This equipment generates, uses, and can radiate radio frequency energy. 
Therefore if the equipment is not installed properly, it may cause 
interference with radio communications. The equipment has not been tested 
for compliance with the appropriate FCC rules designed to provide 
reasonable protection against such interference when operated in a 
commercial environment. Therefore when operating the equipment in a 
residential area, the user may be required to take whatever measures are 
needed and incur any expenses necessary to eliminate interference; it is the 
user's responsibility to verify that the system complies with the applicable 
FCC emission limits. 

High Voltages 

High voltages are present in the sonar head, the power amplifier and the 
topside processor. Always use caution when removing the electronics from 
these devices. 

Improper Line Voltage 

Operation with improper line voltage may cause serious damage to the 
equipment. Always ensure that the proper line voltage is used.
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Foreword 

This startup guide is intended to provide the user with an understanding of 
how to deploy and operate the 4600 System in order to complete a 
hydrographic survey using EdgeTech’s DISCOVER and an approved 3rd Party 
Acquisition and Post-Processing Software.  The approved 3rd Party Topside 
specific to this startup guide is HYPACK®’s Hydrographic Surveying Software.   

EdgeTech assumes the end user has an assembled and tested 4600 System.  
It is also assumed that the user has a high level knowledge of the specific 3rd 
Party Topside Software, and if this is not the case, then training is required 
before proceeding. 

The contents encompassed within this STARTUP GUIDE provide a brief overview 
of the 4600 System and its basic operations.  All other information (i.e. 
Warranty, Complete System Installation, Technical Details, Care and 
Maintenance, etc.) regarding the 4600 System is described within the 4600 
Reference Manual. 
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EdgeTech’s 4600 Startup Guide 

 

1. Introduction 
 
The complete 4600 Bathymetry and Side Scan Sonar System consists of the 4600 Swath 
Bathymetry and Side Scan Sonar Head and the 4600 Topside Processing Unit (TPU). 
 

 

Figure 1:  4600 Topside Processing Unit (Left) and Sonar Head (Right) 

 

EdgeTech’s 4600 is a combined, fully integrated swath bathymetry and side scan sonar 
system that produces real-time high resolution 3D maps of the seafloor while providing co-
registered simultaneous side scan and bathymetric data.  The 4600 Sonar Head’s side scan 
sonar arrays are mounted on a streamlined body that is deployed over-the-bow of a survey 
vessel via a pole.  Sonar data is transferred from the transceiver to the Topside Processing 
Unit on board via an Ethernet network interface.  A detailed description of the 4600 Sonar 
Head configuration is presented in the REFERENCE MANUAL and its main components are 
illustrated in Figure 2.   
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Figure 2:  4600 Sonar Head Components 

 

The 4600 Swath Bathymetry and Side Scan Sonar Head comes standard with a Sonar 
Processor, Port and Starboard Sonar Arrays, a Sound Velocity Sensor (SVS), a Nose and Tail 
Cone, and a Mounting Bracket.  A Mounting Pole may be purchased separately to secure the 
4600 System to a survey vessel.  

 
Note:  Please become familiar with these terms in Figure 2, as they will be referenced 
throughout the rest of this startup guide.   
 
 

The 4600 Topside Processing Unit includes a 4600 Sonar Interface and a Processor (Figure 
3).  The 4600 Interface provides power to the Sonar Head and a link between the Sonar 
Head, any supporting sensors, and the Processor running EdgeTech’s DISCOVER 4600 Side 
Scan and Bathymetry Acquisition software and an approved post processing software.   

Note 1:  At this point, the only hydrographic surveying and post processing software 
that has been approved by EdgeTech to interface with the 4600 software is HYPACK®.  
EdgeTech has worked exclusively with this company to provide a user friendly interface 
for the 4600 System.       

Note 2:  The 4600 Topside Processing Unit comes standard with a third party software 
pre-installed unless the customer has specified otherwise upon time of purchase.    Also, 
installing other software besides the ones supplied with the system can have undesirable 
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effects, such as poor and/or slow performance when acquiring bathymetry and side scan 
data, and the possibility of missing and/or incomplete data being acquired. 

 

Figure 3:  4600 Topside Processing Unit 

 

The end user needs only to supply a source of data for position (latitude/longitude) and 
heading measurements, as well as roll, pitch, and heave data, to complete the acquisition 
package.  Some examples that provide these types of data are presented in Figure 4. 

 

   

Figure 4:  Optional GPS (Left)* and MRU (Right)** Sensors 
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*GPS provides position (latitude/longitude) and may or may not provide heading. 

**MRU provides a source of roll, pitch, and heave measurements.  
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2.  Product Specifications 

      

                230 kHz Model        540 kHz Model 

Physicals 
Size   : 1210 L x 260 W x 230 H (mm)  1210 L x 260 W x 230 H (mm) 
     47.64 L x 10.13 W x 9.18 H (in) 47.64 L x 10.13 W x 9.18 H (in) 
Weight   : 44 kg (98 lbs) 44 kg (98 lbs) 
Construction   : Aluminum and Polyurethane  Aluminum and Polyurethane 
Color   : Yellow and Black Yellow and Black 
Sealing   : Watertight Cover O-ring Seal  Watertight Cover O-ring Seal 
       with Purge Valve with Purge Valve 
 
 
Side Scan Sonar 
Frequency : 230 kHz 540 kHz 
Range (per Side) : 225 m (738 ft) 125 m (410 ft) 
Range Resolution : 30 mm (1.18 in) 15 mm (0.6 in) 
Beam Width Along Track : 0.64° (2-way) 0.5° (2-way) 
Depression Angle : 30° 30° 
 
 
Interferometric Swath Bathymetry 
Maximum Swath : 350 m 150 m 
Range Resolution : 60 mm (2.36 in) 30 mm (2.36 in) 
Ping Repetition Rate : 25 m (82 ft) = 30 Hz,  25 m (82 ft) = 60 Hz, 
  50 m (164 ft) = 15 Hz, 50 m (164 ft) = 30 Hz, 

    100 m (328 ft) = 7.5 Hz 100 m (328 ft) = 15 Hz 
Max Depth Below Tx : 120 m 50 m 
 
 
Sonar Head Power Requirements 
DC Input : 48 VDC 48 VDC 
Power : 100 Watts 100 Watts 
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Environment 
Operating Temperature :  0°C to 40°C (32°F to 104°F)    0°C to 40°C (32°F to 104°F)   
Storage Temperature : -20°C to 60°C (-4°F to 140°F) -20°C to 60°C (-4°F to 140°F) 
Relative Humidity : Operating 0 to 80%,  Operating 0 to 80%, 
  Non-Operating 0 to 100% Non-Operating 0 to 100% 
 
Topside Interface 
Interface : 100 baseT Ethernet 100 baseT Ethernet 
  Serial RS-232 Serial RS-232 
Power Supply : 110/220 VAC Auto-Sensing 110/220 VAC Auto-Sensing 
 
 
Topside Processor 
Operating System : Windows 7 Windows 7 
Interface : 100 baseT Ethernet,  100 baseT Ethernet 
  Serial RS-232 Serial RS-232 
Display : Dual 21” LCD Monitors,  Dual 21” LCD Monitors, 

  Expandable to 4 Expandable to 4 
Storage  : 1TB min Hard Drive & RW-DVD 1TB min Hard Drive & RW-DVD 
Power Supply : 110/220 VAC Auto-Sensing 110/220 VAC Auto-Sensing 
  
 
 
Supplied Components 
 
 4600 Swath Bathymetry and Side Scan Sonar System with 20 m (65 ft) Deck Cable 

(Please refer to the Cable Drawing in the Appendix).  
 Sound Velocity Sensor (SVS, located in the nose section of the Sonar Head) 
 4600 Topside Processing Unit – 4600 Interface and Topside Processor with DISCOVER 

4600 Side Scan and Bathymetry Acquisition Software 
 Hypack® Survey and Post-Processing Software 
 System Restore Software (DVD) 
 2 x HP 21 in LCD Monitors 
 HP Keyboard and Mouse 
 2 x Power Cables 
 Spares Kit 
 Manuals on CD 
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Optional Equipment 
 
 4600 Mounting Pole (see drawing in Figure 5 on Page 8) 
 Crescent VS100 Series Hemisphere GPS (Figure 4, Page 3) 
 SMC IMU Sensor (Figure 4, Page 3) 
 HP 25 in LCD Monitor 
 Samsung 25 in LCD Monitor  
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Optional Mounting Pole Example: 

 

 

 

 

Figure 5:  Mounting Pole Concept Drawing 
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3. Overview 

3.1 Data Formats 
 

In order to collect valid survey data, the following is required to support the survey 
operations and correct processing of the 4600 Bathymetry and Side Scan echo data: 

a. GPS Position in NMEA format, latitude and longitude, 
b. Heading data in NMEA format or EM1000 binary format, 
c. Roll, Pitch and Heave data in TSS1 or EM1000 binary format, and 
d. Time sync data in NMEA format. 

This data may be supplied by 1, 2, or 3 individual sources. 

a. Position Data – this may be supplied via any of the following NMEA type 
sentences/messages: 

i. $xxGGK  ** (Applanix PosMV Format) 
ii. $xxGGA 
iii. $xxGLL 
iv. $xxRMC 
v. $PTNL, GGK, …  ** (Trimble Format) 

** = Non-NMEA standard sentences 

b. Heading Data – this maybe input via: 
i. NMEA, $xxHDT sentence, or 
ii. EM1000 binary format along with attitude data 

 
c. Roll, Pitch, and Heave Data – this may be input via: 

i. EM1000 binary format, or 
ii. TSS1 format 

 
d. Time Input - supported sentences are in order of (priority/use) 

i. $xxZDA 
ii. $xxGGK (derived from data in item a. above) 
iii. $xxGGA 
iv. $xxRMC 
v. $xxGLL 

At minimum, items a., b., and c. above are required and must be supplied.   
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The rest of this section presents an overview of the systems connections, data flow, and 
installation considerations for the 4600 System. 

3.2 System Connections and Data Flow 

3.2.1  Ethernet LAN Connections 

The Ethernet LAN connection from the Sonar Head to the 4600 Topside Interface is 
made using a physical wired connection via the standard 15 m deck cable.  This 
cable is fixed to the Sonar Head and provides a 20 pin Amphenol Industrial connector 
for direct connection from the Sonar Head to the 4600 Sonar Interface.  The 4600 
Sonar Interface then connects to the Topside Processor via a standard RJ-45 
Ethernet plug.  The Topside Processor auto-senses straight and crossover Ethernet 
cables. 
 

3.2.2  COM Ports 

There are three COM ports provided on the 4600 Sonar Interface.  COM1 and COM2 
have been configured for high speed and high accuracy (10Mbps).  COM3 is 
configured for standard connections.  These COM ports are provided to intake the 
navigation, heading, roll, pitch, and heave data from the supporting sensors. 
 

3.2.3  Hardware Connections 

The following is a block diagram that illustrates the interconnections between the 
4600 Swath Bathymetry and Side Scan Sonar Head, the 4600 Topside System, and 
all supporting sensors.  
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Figure 6:  Hardware Data Flow Diagram for the 4600 System 

A larger representation of Figure 6 is provided in the Appendix. 

A more detailed block diagram demonstrating the interconnections and inputs to the 
4600 Sonar Interface (Top section of the 4600 Topside Processing Unit) is shown in 
Figure 7.  This illustration also gives three examples of possible sensor 
configurations.   
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Figure 7:  Sonar Interface Connections 

 

Here, the 4600 Sonar Interface connects to the Sonar Head via the 20 pin Amphenol 
connector and Deck Cable.  Navigation, heading, roll, pitch, and heave data from the 
supporting sensors via COM ports 1, 2, and/or 3, are inputted at the Sonar Interface, 
passed through the Deck Cable, and logged by the Sonar Processor in the Sonar 
Head.  These data are then transmitted, along with the raw side scan data, with a 
common timestamp up the deck cable to the 4600 Sonar Interface, and passed to 
the Topside Processor via Ethernet Port 1 (IP Address: 192.9.0.100) via the Deck 
Cable.  The Topside Processor then processes these data using the DISCOVER and 
BATHYMETRY software to send amplitude, angle and range data to the HYPACK® 
software for logging and post processing.  This process is explained in further details 
in the following section.  The HYPACK® and DISCOVER Side Scan/Bathymetry 
processors all run on the same computer. 

The first example depicts an Applanix PosMV system interfacing to the 4600 Sonar 
Interface.  This type of system provides navigation (latitude/longitude), heading, roll, 
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pitch, and heave data and so no other sensor is required.  The PosMV should be 
connected to COM1 or COM2. 

The second example shows the most common interfacing scenario, a GPS that 
provides navigation and heading data, accompanied by a motion sensor for attitude 
measurements.  The COM ports should be assigned as such: 

 COM1 = GPS (Navigation and Heading) 
COM2 = MRU (Roll, Pitch, Heave) 

These assignments may be interchanged between COM1 and COM2 because both 
ports have been configured for high speed and high accuracy. 

The third and last example portrays the situation where the supplied GPS does not 
provide heading data.  In this case, three sensors are required – a GPS for 
navigation (latitude/longitude), a Gyro for heading, and a motion sensor for roll, 
pitch, and heave measurements.  Therefore, all three COM ports should be used and 
assigned as follows:  

COM1 = Gyro (Heading) 
COM2 = MRU (Roll, Pitch, Heave) 
COM3 = GPS (latitude/longitude) 

 
The sensors allocated to COM1 and COM2 may be interchanged because of the same 
reason stated above in the second example.  The GPS data, or latitude and longitude 
data, must be allotted to COM3 because it is not as important as the first two 
measurements. 
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3.2.4  Sonar Data Flow 

To illustrate the data flow between DISCOVER, the BATHYMETRY PROCESSOR, and 
HYPACK®, the following block diagram is used. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 8:  Sonar Data Flow 

 

As demonstrated by the flow chart, the 4600 Sonar Interface acquires the heading, 
position (latitude/longitude), and motion (roll, pitch, and heave) data and relays this 
information to the 4600 Sonar Head via the Deck Cable.  Here, the information is 
combined with the raw sonar data, time stamped with a common value, and sent 
back to the 4600 Sonar Interface.  DISCOVER intakes the raw sonar data and sends it 
to the BATHYMETRY PROCESSOR, where the raw data is converted to range and angle 
data.  The BATHYMETRY PROCESSOR transmits this range/angle data back to DISCOVER, 
where it is then displayed on the monitor, recorded as a *.JSF file, and packaged 
with the heading, position, motion, and side scan data.  This complete data package 
is then sent to and used by HYPACK to generate three-dimensional bathymetry data 
files and to display side scan and bathymetry data on a monitor.  Finally, these 
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three-dimensional bathymetry data files (.HSX) can be used post survey to generate 
hydrographic final products. 

3.3  System Installation  
 

The 4600 System’s installation on the survey vessel is the customer’s responsibility, and 
certain considerations need to be kept in mind.  The Sonar Head can be mounted on the 
side of a vessel, but it is recommended to secure the 4600 to the bow of the boat.  
Consideration must be given to keel clearance for both cases.  This section outlines the 
4600 Sonar Head deployment options. 
 
Note: If interested in purchasing the optional mounting pole for the 4600 installation, 
please contact Customer Service for a quotation using the information provided on page 
46. 

 

3.3.1  Over-the-Bow Deployment 

The first and recommended option is to mount the 4600 Sonar Head to the bow of 
the survey vessel.  An example of an over-the-bow deployment is depicted in the 
photographs in Figure 9.  A larger representation of these photographs is given in 
the Appendix.  If help is needed with this type of installation, please do not hesitate 
to contact EdgeTech using the information provided in the Customer Service Section 
on page 46 of this manual. 
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Figure 9:  4600 Deployment, Option 1:  Over-the-Bow 

3.3.2  Over-the-Side Deployment 

An alternative to the latter is to mount the 4600 Sonar Head over the side of the 
survey vessel.  An example of an over-the-side deployment is illustrated in the 
images in Figure 10.  A larger representation of these photographs is given in the 
Appendix.  If help is needed with this type of installation, please do not hesitate to 
contact EdgeTech using the information in the Customer Service Section on page 46 
of this manual. 
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Figure 10:  4600 Deployment, Option 2:  Over-the-Side 
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4. Principles of Operations 
 

4.1 Sensor Installation 
This section outlines the steps taken to install the 4600 Sonar Head and supporting 
sensors used to collect navigation, heading, roll, pitch, and heave data. 

1. Mount the 4600 Swath Bathymetry and Side Scan Sonar System to the hull of 
the survey vessel.  Please read the deployment configurations in Section 3.2 
on page 15 and 16 for Sonar Head installation.   
   

2. Position and secure a motion sensor to the vessel.  Two positions for this are 
considered. 

a. Position 1:  Mount the motion reference unit (MRU) at the vessel’s 
center of motion.  This method requires a very stiff mounting of the 
Sonar Head to the boat.  Any angular displacements between the sensor 
and the Sonar Head, induced as a result of roll/pitch motion and 
pole/mount bending, will be transferred to the final dataset.  This 
method subjects the MRU to the least amount of lateral accelerations 
during vessel roll/pitch.  Lever arm corrections for heave displacements 
must be applied. (Recommended) 

b. Position 2:  An alternative method is to attach the MRU to the top of the 
Sonar Head’s mounting pole.  In this case, the pole mount to the vessel 
needs to be stiff only in the yaw place, so that the vessel heading is still 
accurately coupled to the Sonar Head heading.  This method is best if 
the pole/boat coupling is not ideal.  Lever arm corrections for heave 
displacements are not required.  However, long term roll angles changes 
(due to crew movement, etc.) are not corrected for. 
 

3. Measure the depth of the Sonar Head and its location relative to the MRU 
sensor.  If the MRU was attached to the Sonar Head’s mounting pole, 
measure the relative location of the MRU sensor to the vessel’s center of 
motion.  Record these measurements as they will be used later as Offsets in 
HYPACK. 
 

4. Setup the GPS as described in the GPS’ user manual. 
 

5. Connect the Sonar Head to the 4600 Topside Interface via the 20 pin 
Amphenol Industrial connector. 
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6. Connect the GPS to COM1 and the MRU to COM2 (assuming the GPS provides 
heading as well as position in latitude and longitude). 

Note: An alternative configuration might require a third sensor, such as 
a Gyro for heading data.  In this case, the Serial port assignments 
should be Gyro = COM1, MRU = COM2, and GPS Position = COM3.  
Refer to Section 3.2.3 for more details. 

7. Ensure the Ethernet from Port1 of the 4600 Topside Interface is plugged into 
the Ethernet Port1 of the Topside Processor (labeled SONAR). 
 

8. Turn the Sonar Head ON by using the switch on the front side of the 4600 
Topside Interface. 

 
9. Wait several minutes.  This waiting period allows the Sonar Head’s processing 

unit to connect with the Topside Processor.  
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4.2 Confirming Supporting Data is Present 
 

To ensure the Sonar Head’s processing unit is communicating properly with the Topside 
Processor, follow these steps. 
 

1. On the Desktop, launch Shortcut to sonar.exe.  The following window should 
appear. 

 

Figure 11: Sonar 192.9.0.101 Remote Desktop Connection Window 

2. Check the clock time of the sonar (bottom right hand corner of Figure 11) with 
the clock time from the GPS and the Topside Processor.  Ensure all three have 
the same time stamp. 
 

3. Click on Menu > Misc > Serial Port Information… 
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4. Check each COM port in the drop down menu to ensure data is coming through 

for each device and in the correct format (Figure 12). 
a. COM1 = MRU 
a. COM2 = GPS 
b. COM4 = Sound Velocity Sensor in the nose of the Sonar Head 

 
Note:  The GPS and MRU are interchangeable on COM1 and COM2 as long 
as the appropriate baud rate is set in the drop down menu next to the 
channel assignment in the Serial Port Information Window (Figure 12, red 
arrow). 

If all systems are working properly, close this window and proceed to Step 5.  If 
there is an issue with one of the ports, please contact Customer Service using the 
provided information on page 46.   
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Figure 12:  Serial Port Information Window 

5. Now click on Menu > File > Show Status.  The System Status window will 
appear as shown in Figure 13. 
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Figure 13:  System Status Window 

 
6. On the right hand side of the window, click on the Config bullet under the 

Update button and then on the drop down menu named Config Item. 
 

7. Select Serial and then click the Update button several times. 
 
8. Check to make sure all sensors’ usage percentages are well below 80%.  If they 

are not; increase the baud rates of the sensors until these percentages drop. 
 
9. When satisfied with the incoming data, press OK in the System Status window, 

and then minimize the Sonar – 192.9.0.101 – Remote Desktop Connection 
window.  
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4.3 DISCOVER 4600 AND THE BATHYMETRIC PROCESSOR 
 

EdgeTech’s DISCOVER display and control application allows recording of side scan and 
range/angle bathymetry data in the binary EdgeTech JSF file format.  The JSF file format 
has been in use for 10+ years and has new public extensions to support the additional 
bathymetry data messages.  This section states the basic functions of DISCOVER and the 
BATHYMETRIC PROCESSOR and how to operate them during a survey.  A full description of 
DISCOVER is given in the 4600 REFERENCE MANUAL.  If you are not familiar with previous 
versions of DISCOVER, please read Section 5.2 of the REFERENCE MANUAL before continuing. 
 
1. Launch DISCOVER 4600 using the Desktop shortcut.  The two main windows will 

appear as in Figure 14 and Figure 15. 
 

 
 

Figure 14: DISCOVER Main Window 
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Figure 15:  BATHYMETRIC PROCESSOR Main Window 
 
 

2. Ensure that the Sonar Head is connected to DISCOVER by ensuring the network is on 
(NET: ON) down in the right hand corner of the DISCOVER main window (Figure 14, 
circled in blue). 
 

3. Check the clock time in DISCOVER and ensure it corresponds to the sonar, GPS, and 
Topside Processor’s clocks.  This is done by looking at the time stamp listed next to 
the word Time: (Figure 14, arrow indicator in blue).  
 

4. Navigate to the Towfish Control Tab and check the Sonar On box to turn ON the 
Sonar Head. 
 

 

Figure 16:  Towfish Control Tab - Turning the Sonar On 
 
 

Note: If at any time, one or more of the systems (i.e. GPS, MRU, Sonar Head) have 
been disconnected or are not sending data to DISCOVER while the Sonar Head is 
turned on, a window (Figure 17) will appear displaying the unavailable system(s).   
 
If this window appears, check the connection to the unavailable system(s).  If the 
problem persists, please call Customer Service using the information provided on 
page 46. 
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Figure 17: Diagnostic Information Window 
 
 

5. Ensure the correct supporting information is being inputted to the system on the 
appropriate COM ports by choosing View > Situation Status on the Bathymetric 
Processor main window (Figure 18 and Figure 19). 

 

Figure 18: Selecting the Appropriate Ports 

 

The choices available are OFF, ANY, COM1, COM2, etc.  Ensure the correct strings 
(i.e. GGA, HDT, VTG, etc.) are set to ANY or set to their corresponding COM port.  If 
only one source of each piece of information is provided to the system, the Situation 
Status window may look like the one presented in Figure 19.  Also, the processed or 
not processed pitch/roll data is presented in this window as well. 

 

 

Sonar Head is ON 
and CONNECTED 

SVS is ON and 
CONNECTED 

GPS/MRU is DISCONNECTED 
MRU/GPS is DISCONNECTED 
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Figure 19:  Situation Status Window 

 

6. To set up a recording directory, navigate to the Disk Tab and click Browse next to 
the Record File box.  Usually the recording directory is located on the F:\Data Disk. 
 

 

Figure 20:  Disk Tab in DISCOVER - Record 

 
7. When ready, press the Record button on the right hand side of the Disk Tab.  The 

name of the file will appear in the Record File: text box.  To stop or pause a file, 
select the appropriate function button. 

Note:  If a file is recorded in DISCOVER while data is being recorded in HYPACK, the file 
can be re-processed for bathymetric estimation using different parameters post-
survey.  This recorded DISCOVER file provides useful for debugging and training 
purposes. 

7. For basic playback, navigate to the Disk Tab (Figure 21) and select Browse next to 
the Playback File: box.  Locate the desired JSF file and use the function buttons to 
play, stop, fast forward, etc. (boxed in green). 
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Figure 21: Disk Tab in DISCOVER - Playback 

8. To adjust the basic bathymetric processing parameters in DISCOVER, select 
Bathymetry from the Top Menu and then Processing Parameters (Figure 22 and 
Figure 23). 
 

 

Figure 22: Discover 4600 Top Menu - Selecting Bathymetric Processing Parameters 

 

Here you can turn on/off the BATHYMETRIC PROCESSOR, adjust the echo strength 
(1/10%), SNR filter (dB), and Minimum Process Range (m). This window also allows 
you to specify if you would like to use/not use the external limits given by the 3rd 
Party Interface.  The recommended parameters are shown in Figure 23 for a 
silty/sand type seafloor. 
 

   

Figure 23:  Basic Bathymetry 

Note 1:  Ensure the Bathymetric Processing box is checked while recording a file, 
otherwise no bathymetry data will be processed or sent to Hypack. 

1 

2 

3 

4 
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For a full description of all the functions in DISCOVER and the BATHYMETRIC PROCESSOR 
please refer to Section 5.2 in the 4600 REFERENCE MANUAL. 
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4.4 Operating HYPACK® 
 
The processed bathymetry and side scan data is sent in real-time to the 
HYPACK®/HYSWEEP® survey applications.  These application display and record the 
bathymetric data in HYPACK’s HSX format.  These HSX files can then be used off line in 
the MBMAX, SIDE SCAN MOSAIC, and other proprietary packages that support these 
formats, to edit, clean, and mosaic the collected data.  This segment briefly explains 
how to use HYPACK® in order to complete a hydrographic survey.  For more information 
on how to use HYPACK with the EdgeTech 4600 System, please refer to the EDGETECH 

4600 HYPACK SOFTWARE GUIDE. 
 
Note:  This section assumes the end user has a high level knowledge of HYPACK.  If not, 
it is the sole responsibility of the customer to acquire training/support from HYPACK. 

 
1. Place the white HYPACK Dongle in the front USB port of the 4600 Topside 

Processor in order to activate the HYPACK License. 
 

2. Launch HYPACK and copy the EdgeTech4600 Project.  This will copy all the 
necessary files in order to complete a survey with the 4600 system (Figure 24). 

 

Figure 24:  Copy Project Window 
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3. Give the copied project a relevant name, such as the area to be surveyed and the 
date (i.e. Port Everglades 10-28-2010). 

4. Now, configure the Geodetic Parameters for the survey area.   
a. Select Preparation from the top menu in the HYPACK Shell (Figure 26, 

circled in red) and click on Geodesy.  This same window may be reached 
by choosing the Geodesy shortcut from the shortcut menu (designated by 
red arrow in Figure 26).  The following window should appear: 
 

 

Figure 25:  Geodetic Parameters Window 

 

b. Configure the parameters according to the survey area. 
c. When finished, click OK. 

 
5. Load any necessary background files needed to complete the survey. 

a. Under Project Files on the left side of the HYPACK main window (Shell, 
Figure 26), right click on the Background Files and select Add Files. 

b. Locate the background files needed and select Open. 
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Figure 26:  Hypack Main Window (Shell) 

 
6. Input any offsets for the 4600 Bathymetry and Side Scan Sonar System.  (These 

values depend on how the system was mounted). 
a. Select Hysweep from the top menu of the HYPACK Shell (Figure 26, circled 

in red) and click on Hysweep Hardware.  (Please refer to Figure 27 and 
Figure 28). 

b. Ensure the EdgeTech 4600 system is highlighted. 
c. Select the Offsets Tab at the top. 
d. Enter the offsets for Sonar Head 1, Sonar Head 2, and the MRU.  In 

HYPACK, Sonar Head 1 and Sonar Head 2 represent the array on the 
port and starboard side of the underwater unit (Figure 2), respectively.  
Both sonar heads should have the same Forward and Vertical Offsets, 
while the Starboard offset should differ according to the acoustic centers. 
(Please refer to the Appendix for the Acoustic Center locations of each 
array).   
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e. When finished, click Close.   
 

 

Figure 27:  Hysweep Hardware Window 

 

 

Figure 28:  Hysweep Hardware Offsets 
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Note: These offsets are measured with respect to the vessel’s center of 
motion and should have been collected during sensor installation. 

7. Select Survey on the top menu of the HYPACK Shell (Figure 26, circled in red) and 
choose Survey and Hysweep Survey.  Five windows will appear as in Figure 29 
and Figure 30:  (1) Survey, (2) GPS NMEA-0183 with RTK Tide Option, (3) 
Edgetech 4600 Navigation, (4) Hysweep Survey, and (5) Hysweep Interface.  

Note:  The GPS NMEA-0183 with RTK Tide Option and Edgetech 4600 Navigation 
windows will only appear if you have configured the mobile devices properly as 
described in Section III of the EDGETECH 4600 HYPACK SOFTWARE GUIDE.  This is why 
it is important to copy the EdgeTech 4600 project as these devices are already 
configured for EdgeTech’s system. 

8. Before continuing, ensure all systems and inputs are green in the Hysweep 
Survey window (Figure 30, top).  Green indicates that each system and input is 
connected properly and all devices are on.  If a device is highlighted in red, 
DISCOVER should have already displayed a warning message.  Check the 
connection between the device and the Topside Processor.  If problems persist, 
please contact Customer Service using the information provided on page 46. 
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Figure 29: Survey and Hysweep Survey Windows – Windows 1 through 3  
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Figure 30:  Survey and Hysweep Survey Windows – Windows 4 and 5 

 

9. On the Hysweep Survey window (Figure 30, top), choose View > Interferometry 
to bring up the interferometry window. 

 

 

Figure 31:  Interferometry Window 

10. Select the first button in Figure 31 to access the Ranges tab in the View Options 
window (Figure 32). 

 
This window allows the user to control the Minimum and Maximum Depth, Port 
and Starboard Offset Limits, Port and Starboard Angle Limits, and the Depth 
Range to Overlap Colors limit. 
 
 

Range Settings 

Display 

Interferometry Options 

Display Options 
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Figure 32:  View Options Window – Incorrect Way of Limiting Data 

 

Note 1:  It is important to note here that it is not a good idea to limit your data by 
setting the Port and Starboard Angle Limits under the Ranges tab (Figure 32).  
When the Port and Starboard Angle Limits are set too low (> 90°), the data 
becomes biased, resulting in a false curvature of the seafloor.  Figure 33 and Figure 
34 illustrate this “biasing” concept. 

Note 2:  The Port and Starboard Angle Limits in this example have been set to 
55˚, the field of view of a traditional multibeam! 

X 
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Figure 33:  Interferometry Window Illustrating a Biased Data Set Caused  
by too low of a Port and Starboard Angle Limit 

 

 

 

Figure 34:  Profile Window Illustrating a Biased Data Set Caused  
by too low of a Port and Starboard Angle Limit 
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Since the 4600 System has a 200˚ field of view, the correct way to limit the 
bathymetry data is setting the Port Angle Limit and the Starboard Angle 
Limit set to 100˚ (Figure 35).   

 

 

Figure 35:  View Options Window – Correct Way of Limiting Data 
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If the data needs to be limited, adjust the Port and Starboard Offset Limits instead.  
This will only keep the data points included within the horizontal range specified by these 
offset limits without biasing the data points. A proper way to threshold the data is 
demonstrated in Figure 36 and Figure 37. 

 

 

Figure 36:  Correct Window Thresholding (Interferometry Window)  

 

 

Figure 37: Correct Window Thresholding (Profile Window) 

 

11. Select the third button in Figure 31 to access the Interferometry Options.  This 
window may also be accessed by right clicking on the Interferometry window and 
selecting Options. 
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12. Check the Filter along track box under Filtering (boxed in red in Figure 38).  Set the 

number of bins to 50 and set the Height/Weight between (2-5)/(0.3-0.6).  The 
parameters shown below work well for rejecting bad data when the seafloor is behind 
an object. 

 

 

Figure 38:  Interferometry Options 

 

13. Under Beamforming (boxed in green, Figure 38), the number of beams or number 
of points per swath should typically be less than or equal to 400.   

 
14. Ensure that the Mode drop down menu is set to Bin by Horizontal Offset. 

 
15. The Bin Size should be set to a value that will get the desired Max Width (or max 

swath coverage).  Here the number of beams was set to 240 and the bin size was 
set to 0.5 m to acquire the desired swath coverage of 120m.   

Note:  For higher resolution, the recommended settings are 400 Beams, by 0.25m 
Bin Size to achieve a total swath of 100m.  If a smaller/larger swath is desired the 
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Bin Size can be adjusted accordingly, or the Port and Starboard Offset Limits can be 
fine-tuned. 

 
 

16. On the Hysweep Survey Window (Figure 30, top) choose View > Profile Window to 
bring up the two-dimensional profile of the seafloor (Figure 39). 
 

 

 

Figure 39:  Profile Window using Sounding Points Viewing Option 

 

17. Click on the second button in Figure 39 to bring up the Display Options.  This window 
may also be accessed by right clicking on the Profile Window and selecting 
Options, or by hitting the F9 key. 
 

18. This window allows the user to pick and choose different viewing methods of the 
data.  Choose each one and hit Apply to see what the data looks like.  (The 
preferred viewing is shown in Figure 40).  When finished, click OK. 

 

Range 

Display 
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Figure 40: View Options Interface, Display Tab 
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19. On the Hysweep Survey Window choose View > Multi-Beam Waterfall to bring up 
the waterfall view of the seafloor. 
 

 

 

Figure 41:  Multibeam Waterfall using Color Tin Viewing Option 

Note 1:  Range Settings and Display Options buttons for all three windows, 
portray the same settings from the same window.  The Sounding Colors button 
allows the user to change the color scheme of the Multibeam Waterfall 
window. 

Note 2:  There are other windows that Hysweep Survey provides and these are 
accessed the same way as in step 16.   

 
20. When ready to collect data, select the Start Logging feature from the Survey 

window by Logging > Start Logging… or by selecting the shortcut key . 
 

 

Figure 42:  Survey Window (First Display Window in Figure 30). 

Range 

Display 
Sounding Colors 
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Note:  DISCOVER could be recording simultaneously as HYPACK is logging data. If 
desired, navigate to DISCOVER and click the Record button from the Disk tab. 

 
19. When finished with collecting data, select the Stop Logging feature from the 

Survey window by Logging > Stop Logging… or by selecting the shortcut key

.  

Note:  If DISCOVER was recording, please make sure to stop this recording too.  
For more details on logging survey data please refer to Section IV of the 
EDGETECH 4600 HYPACK SOFTWARE GUIDE. 

20. Repeat Steps 20 and 21 for as many data files as needed to complete the survey. 
 

21. When completed with the survey, save and exit out of all applications and turn 
off the 4600 system using the power switch on the Topside Interface. 
 

22. Shut down the Topside Processor by exiting out of all programs, then Start > 
Shut Down.  



        
 
 

4600 Startup Guide Page 46 of 46 0012884_REV E 
 

4600 Swath Bathymetry  
and Side Scan Sonar 

  

5. Contact and Service Information 
 

For product service or support, please contact: 

EdgeTech 
4 Little Brook Road 
West Wareham, MA 02576 

 
Tel: (508) 291-0057 
Fax: (508) 291-2491

 

Email: service@edgetech.com 

 

Note:  If it is necessary to return the equipment for service, a Returned Material 
Authorization (RMA) number is required prior to returning any equipment to EdgeTech.  
This is to assist EdgeTech in recognizing the returned equipment when it arrives at 
EdgeTech’s receiving dock, and to assist customer service representatives in tracking 
the returned equipment while it is at EdgeTech’s facilities.  Please refer to the 4600 
REFERENCE MANUAL for the correct RMA Procedure. 
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Deck Cable Drawing 

 

20 Meters 
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4600 Acoustic Centers (Standard Body Type) 

 

 


